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Dear students, 

The infinite possibilities of Information and Communication Technology 
have made many things that seemed impossible, possible. The ICT  
textbook for Standard 8 has been designed to guide you into the world of 
technology, facilitating self-learning, doubt clearance and knowledge  
construction.

Using this book, you can practice word processing, spreadsheet and  
presentation software and engage in various activities. In addition, by using 
block coding, you can create computer games and learn the fundamental  
principles of machine learning. The history and various services of the  
internet are also explored in this textbook.

The textbook also includes resource creation using multimedia tools, such 
as digital painting, video editing, and music composing. Let this ICT text-
book help you acquire new knowledge and enhance your creative abilities 
by effectively using digital technology in the learning process. 

                      			   With regards,

	 Dr. Jayapralash R.K. 
Director
SCERT
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Chapter 6

Machines That Learn
Haven’t you seen the picture of friends trying to teach sign 
language to a robot?

Have you noticed how people with hearing impairments 
communicate using sign language? If you ever get a chance 
to meet such individuals, how would you communicate with 
them? Wouldn’t it be easier to interact and exchange ideas if 
you learned their language?

As members of society, it is our responsibility to include 
differently abled individuals in the mainstream and to help them 
overcome their challenges. If we could teach sign language to 
machines, wouldn’t we be able to use technology in a way that 
helps people with hearing impairments?

Machines that Learn
You have understood that machines can learn and also apply 
what they have learned in new situations, haven’t you?

Let’s look at some examples of such situations.

	� A screen lock that opens by recognizing the owner's face.
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	� Voice assistant systems that help control devices in homes.

	� ...............................................................................................

	� ...............................................................................................

Do you know how machines learn? 

Let’s try an activity to understand this better. Observe the 
patterns given in both columns of Table 6.1.

Group - A Group - B

Table 6.1 Various Patterns

Analyse the patterns given in both groups, and identify and note 
down which group each pattern in Table 6.2 belongs to.

Group :_________ Group :_________ Group :_________ Group :_________ Group :_________

Table 6.2 – Classification of Patterns
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Think about the different steps you went through to classify the 
patterns.

	� Identified the unique features of the patterns given in both 
groups.

	� By comparing the images, identified the specific features that 
distinguish the patterns in the two groups and remembered 
them.

	� Carefully observed each of the new patterns given in Table 
6.2 and identified their distinct features.

	� Based on the features that differentiate the patterns in 
Group A and Group B, classified each new pattern into the 
appropriate group.

To classify the patterns, there must be one or more distinct 
features that help differentiate the patterns in each group. 
Record the similarities and differences you have identified 
between the patterns in Group A and Group B in Table 6.3 
given below.

Similarities Differences

The patterns are in black and white. The lines in the patterns of Group-A are 
mostly curved. In the patterns of Group B, 
most of the lines are straight.

The patterns in Group-B have more sharp 
edges.

Table 6.3 Similarities and Differences Between the Patterns

The conclusions you arrived at by analysing the features of 
the patterns helped you decide which group the new patterns 
belonged to. In the same way, the knowledge we gain from our 
everyday experiences enables us to respond appropriately to 
different situations.
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It is the network of billions of neurons in the human brain 
that gives us the special ability to understand, think, and make 
suitable decisions.

Artificial Intelligence (AI) is the branch of science that enables 
computers to imitate human intelligence, including intelligent 
behaviour. By providing appropriate data, we can train a 
computer to learn new things. This process is called Machine 
Learning. Through this, computers can analyse information 
in new situations, make predictions, solve problems, and take 
decisions.

Teaching Sign Language to a Computer

To use any language fluently, it must be practised and used 
regularly. To learn sign language, one would normally need help 
from someone who already knows it. But if we could teach a 
computer sign language, anyone could learn sign language with 
the help of a computer. Shall we try to teach the computer the 
sign language representations of the English alphabet?

In Class 7, through the lesson Computer Vision, we learned 
how to create a computer programme using PictoBlox that can 
recognise facial expressions. In that lesson, facial expressions 
were identified using a pre-trained machine learning model.

In a similar way, we now need to create a machine learning 
model that can recognise hand gestures representing the 
letters of the English alphabet. Using the Machine Learning 
Environment in the PictoBlox software on our computer, we 
can build machine learning models for different tasks. For this,

	� Open PictoBlox, go to the File menu, and select the option 
Open ML Environment.

	� In the window that appears, click the Create New Project 
button. This will open a window as shown in Figure 6.1.

Machine Learning

Artificial Intelligence is a scientific discipline, and Machine Learning is one of its subfields. It 
is a technology that enables computers to make decisions in new situations, based on models 
they build on their own by identifying patterns in data.
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Fig. 6.1 Window for Creating a New Machine Learning Project in Pictoblox.

Which types of machine learning projects can be done using 
PictoBlox? Examine the window and list them below.

	� Image Classification 

	� Object Detection

	� ...............................................................................................

	� ...............................................................................................

To create a machine learning model that identifies and classifies 
hand gestures, the Image Classifier feature can be used. For 
this purpose,

Hand Pose Classifier and Indian Sign Language

The Hand Pose Classifier feature in PictoBlox can also be used to recognise and classify 
hand gestures. However, the Hand Pose Classifier is capable of recognising only one hand 
at a time. We are using Indian Sign Language (ISL), in which both hands are required 
to represent the signs for alphabets. Therefore, there is a limitation in creating a machine 
learning model for recognising ISL using the Hand Pose Classifier.
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	� From the window shown in Figure 6.1, select Image Classifier 
as the project type, give it an appropriate name (e.g., ISL), 
and click the Create Project button. Next, a window similar 
to the one shown in Figure 6.3 will appear.

 Indian Sign Language -ISL

Language is essential for communication. 
There are different forms of language. We 
communicate through words, movements, 
and gestures. However, due to limitations 
in acquiring spoken language, individuals 
with hearing impairments often face 
difficulties in communication. As a 
result, they are frequently excluded 
from the mainstream of society. The 
inability to understand the meaning of 
sounds goes beyond what we commonly 
imagine. While people with hearing ability 
communicate using words, those with 
hearing impairments try to communicate 
through gestures. In many countries, 
there are specific forms of sign language 
designed for the hearing impaired. 
For example; in India – Indian Sign 
Language (ISL), in the USA – American 
Sign Language (ASL), in Britain – British 
Sign Language (BSL), in Australia – 
Australian Sign Language (AUSLAN).

Persons with hearing impairments, like 
all individuals with disabilities, are part 
of our society. All the laws and rights that 
exist in our country apply to them as well. These provisions have been implemented through 
legal measures. However, it is often challenging for people with hearing impairments to acquire 
multiple spoken languages. Those without hearing or speech impairments can support them 
by learning sign language. By learning sign language, we can help persons with disabilities 
overcome barriers and lead better lives. It is our responsibility to support and include them.

Fig. 6.2: ISL – Hand Gestures for English Alphabets

Observe Figure 6.3. This is a window used for the activity of 
training the computer by providing images to create a machine 
learning model. Find out how many stages are there in it.
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AI Model

An AI model is a program 
trained using a set of data 
to learn, recognize patterns, 
and to make decisions 
without human intervention. 
AI models are used to 
perform various tasks using 
artificial intelligence.

 Fig. 6.3 The Window that Appears When the Create Project Button is Clicked 

1. Dataset Preparation

Dataset preparation is the process of collecting and accurately 
organizing the data required for the machine learning model 
to learn. The quality of the data influences the accuracy of the 
model. Here, images are to be provided as data.

2. Training

Training is the process of teaching the model using the prepared 
dataset. In this stage, the model learns to identify patterns from 
the data and make predictions.

3. Testing

Testing is the process of evaluating the performance of the 
trained model. As part of this, new data that was not previously 
given to the model is used to check whether it can make 
accurate predictions. Through testing, the model’s accuracy 
and efficiency are assessed.

Machine learning can mainly be classified into three types.

1.	Supervised Learning:          	     	                                                           
This is the process of training the computer using labeled data. Both the input and the 
corresponding output are provided in advance. When new data is received, the computer 
uses the learned pattern to predict the answer.

2.	Unsupervised Learning:	   
This method aims to discover patterns in unlabeled data. The computer identifies hidden 
relationships and structures within the data on its own.

Categories of Machine Learning
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3.	Reinforcement Learning:	 This is the process of learning by understanding right and 
wrong actions. For each action, the computer receives either rewards or penalties, which 
helps it learn to make the correct decisions.

As the first step in creating a model to recognize Indian Sign 
Language, we can train the computer using only the three 
letters A, B, and C.

When the Image Classifier training interface in Figure 6.3 is 
opened, two categories Class 1 and Class 2 will be available. 
Using this, a dataset can only be prepared to classify images 
into two categories. However, to recognize the letters A, B, 
and C, images of their hand signs need to be added under three 
separate categories. In addition, images that do not show hand 
signs should be included in a separate category called "None." 
That means a total of four classes are required. For that purpose,

	� Use the Add Class button below the window to create new 
classes.

	� Click the button  and name each class accordingly  
, , ,  

Now, images can be added to each category.

The hand signs representing the characters A, B, and C in ISL 
are shown in Figure 6.4. These hand signs should be provided 
as image data under each corresponding class.

A B C

Fig. 6.4: ISL Hand Signs for A, B, and C

	� To add images of the hand signs, click the Webcam button 
in each class and add the required sample images for each 
class—ranging from 200 to 500 images (see Figure 6.5).
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While adding samples, 
make sure to include only 
clear and accurate images 

in each category.

Fig. 6.5: Dataset Preparation – Adding Images

The next step is to train the machine learning model using the 
dataset we have created.

Fig. 6.6: Training System

Any image that does not 
belong to the A, B, or C 

categories should be added to 
the None category.
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Fig. 6.7: Graph Displayed After Model 
Training Completion

In Pictoblox, the machine learning model can be 
trained using programming languages like Python and 
JavaScript.

	� To train the model using JavaScript, make sure the 
Training Switch is set to the JavaScript  mode. 
Then, click on  Training Model and wait until 
the training process is complete (see Figure 6.6).

	� Once the training is finished, its status will be displayed 
in the form of a graph (see Figure 6.7). 

Fig. 6.8: Testing Interface

The next step is 
testing. To do this,

	� Click the Webcam 
button in the Testing 
window (Figure 
6.8). In the webcam 
window that appears, 
show the ISL hand 

signs for the letters A, B, and C, one by one.

	�   The performance of the trained machine learning model can 
be understood from the Output window (Figure 6.9).

If the model's efficency is low, unsuitable images included 	 i n 
the dataset may need to be removed. In some cases, it may 
also be necessary to add new images. If such changes are made 
to the dataset, don't forget that the training process must be 
repeated. This process should be repeated until the model is 	
able to accurately recognize the hand signs.

	� After preparing the model, click the  button to save the 
project.

Let’s Create a Sign Language Game
We have successfully trained the computer to recognize the ISL 
gestures for the letters A, B, and C. Now, using this knowledge 
acquired by the computer, let’s try creating a game to help 
practice ISL letters. The details of how the game works are 
given below.Fig. 6.9: Testing Using Webcam
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Game – How It Works

The computer randomly displays a letter. You need to show the ISL hand sign for that letter 
in front of the webcam. If the hand sign is correct, you win the round. 

At this stage, the computer has been trained to recognize only the three letters A, B, and C.  
To see how the game works, watch the video named ISLGameVideo.mp4 provided in the    
School_Resources/Class_8 folder.

To create this game, the most essential component is the AI 
model that recognizes ISL. We have already prepared this 
model in the previous activity. Now, this model needs to be 
exported and included in the game we are going to create.

For this:

	� Start a new project in Pictoblox.

	� From the File menu in the main window, open the ML 
Environment (see Figure 6.10).).

Fig. 6.10: Pictoblox – ML Environment Window
	� Here, you can see the projects 

that were previously created. 
From this list, click to open 
the project that was prepared 
for ISL.

	� Then, in the ML window that 
appears, click the Export 
Model button (see Figure 
6.11).

With this, the ISL model we created 
earlier will be added to the new 
Pictoblox project. As a result, 
various code blocks related to the 
machine learning model will now 
be available in the project (see 
Figure 6.12).

Fig. 6.11 Model Export System

Fig. 6.12: ML Image Classification Code 
Blocks in Pictoblox
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You are already familiar with the code blocks in Pictoblox.

Now, examine the newly displayed code blocks and identify 
the function of each one. Complete Table 6.4 by writing down 
the purpose of each code block.

Code Usage

The image captured by the camera is 
recognized and categorizeed. The model can 
be used to test it.

To determine whether the image captured by 
the camera belongs to category - A

To determine which class the image captured 
by the camera belong to.

Table 6.4 Codes related to Image Classifier and their Uses

Now that the use of code blocks has been identified and the table 
has been completed, let’s add suitable sprites and costumes for 
our game. Since the computer only needs to display the letters 
A, B, and C, to do this,

	� Click the  button and select the sprite named 
 Block-A from the Pictoblox sprite library. Rename this 

sprite to Alphabet (Figure 6.13).

	� Next, open the Costumes tab of the Alphabet sprite and add 
the following costumes: Block-B, Block-C, and Button4-a 
(Figure 6.14).

In the machine learning model we prepared earlier, the class 	
names were given as A, B, and C. The same names must be 	
given to the costumes as well. Therefore,Fig. 6.13 Sprite - A
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	� Rename the costumes accordingly as A, B, and C (Figure 
6.15).

We have already seen how the game works in the video. Now, 
let’s look at the steps of its operation:

	� When the flag is clicked, the camera turns on.

	� One of the letters A, B, or C is displayed randomly.

	� The image captured by the camera is analyzed.

	� If the hand sign shown matches the displayed letter, the letter 
on the screen changes to ( )tick symbol.

	� This process is repeated.

Shall we now prepare the code needed for these actions?

We’ve already learned in earlier classes how to turn on the 
camera using the    code.

At the start of the game, one of the letters A, B, or C appears 
randomly on the screen. To make this happen, one of the first 
three costumes of the Alphabet sprite must appear randomly. 
For this, using the code  is 
sufficient.

The names given to the costumes and the class names in the 
machine learning model are A, B, and C. Therefore, using the 

code  we can check Whether the 

letter displayed on the screen matches the hand sign shown to 
the camera. If they match, what should happen?

	� The Success costume should be displayed.

	� A sound should be played.

	� After 3 seconds, another random letter should appear on the 
screen.

The program required to perform these actions is given in 
Figure 6.16. With the help of Table 6.4, analyze these code 
blocks and discuss in class to find out how each block works.

Fig. 6.14   Sprite - Button4-a

Fig. 6.15   Costumes
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Fig. 6.16: Complete Code of the ISL Game

Wouldn’t the game become more interesting if a score is added 
for every correct answer? You have already learned how to add a 
scoring system in earlier classes. Try adding the score feature to 
the game on your own.

After training the model with ISL hand signs for the remaining 
letters, further develop the game.

Machine Learning and Its Possibilities
Machine learning is a field with vast potential. The method we 
explored (where machine learning models can identify patterns from 
images and classify them) can be used to perform useful tasks in our 
daily lives.
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X-ray systems are a very important tool for diagnosing illnesses. By preparing a large dataset 
of   X-ray images, both with and without signs of disease, a machine learning model can be 
developed for diagnosis. This helps improve the efficiency and accuracy of diagnosis and 
treatment by reducing human error.

Not only images, but also text, sound, video, computer programmes, and many other types 
of data can be used to train the machine. Let’s explore its possibilities and conduct a seminar 
in class on the topic of Machine Learning and Its Possibilities.

Let's Assess

 	 “A robot learns to walk by trying out different movements, correcting errors along the way”.

	 a)	 Unsupervised Learning

	 b)	 Supervised Learning

	 c)	 Reinforcement Learning

	 d)	 Deep Learning

	 In which of the following situations is machine learning being used?

a) 	An app recommends songs you might like based on the songs you frequently listen to.

b)	 A website collects the information entered by the user and stores it in a database.

c)	 Advertisements related to your internet search history are displayed on the websites you 
visit.

d)	 Formulas are used in spreadsheets to simplify calculations.

Extended Activities

1.	 Suppose you need to build a machine to classify two different types of objects — for 
example, a machine that can sort ripe and unripe tomatoes. Create a machine learning model 
in PictoBlox to identify these objects using a webcam.

2.	 Design a game that operates using hand gestures as input instead of a keyboard or mouse, by 
using the Hand Pose Classifier feature in PictoBlox.


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Chapter 7

Data Analysis on a Computer

Take a look at a page from Meenu's account book (Figure 7.1), which contains the 
recorded income and expenses for the months of June and July.

Fig. 7.1 – A Page Showing Recorded Income and Expenses
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Haven’t you examined the income and expenses yet? Now, see 
if you can find the answers to the questions given below.

	� In which month was the highest amount spent?

	� On which item was the highest expense incurred?

	� What is the total amount saved over the two months?

Was it easy to find the answers?

We have just compared the figures for two months. If it were 
for a whole year instead, the analysis would have been much 
more difficult, wouldn’t it?

Is there a better way to organise and prepare such data 
systematically? The spreadsheet software Calc, which you 
were introduced to in earlier classes, is a very effective tool for 
handling tasks like these.

Spreadsheet software is used to organise and analyse 
information. It can be used in various fields such as 
education, personal finance, and business. Some of the 
features available in spreadsheet software are:

	� Data can be tabulated.

	� Charts and graphs can be created to present the data 
more clearly.

	� It enables analysis, comparison, and summarisation of 
information.

A wide variety of spreadsheet software is available today. 
LibreOffice Calc is a spreadsheet software available 
in KITE GNU/Linux. Other examples of spreadsheet 
software include Microsoft Excel, Apache OpenOffice, 
Gnumeric, Calligra Sheets, and Apple Numbers.

Let’s Get Familiar with Calc
Open LibreOffice Calc on your computer and examine the 
software window. Then, observe Figure 7.2 and identify the 
labelled parts.

Spreadsheet Software
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Column Name Row Name Cell Address

A 2

J J24

O 60

Fig. 7.2 LibreOffice Calc interface

1.	 Cell Address

2.	 Active Cell

3.	 ..............................................................................................

4.	 ..............................................................................................

5.	 ..............................................................................................

When Calc is opened, what we get is a worksheet consisting of 
Columns and Rows. Among these,

	� The English letters A, B, C….....… represent ………………… 
…….…. …………............

	� The numbers 1, 2, 3,..…… represent …………………… 
…………..........................

The small rectangles seen in the columns and rows are called 
cells. Each cell is identified by combining the names of its 
column and row (this is called the cell address). Refer to Table 
7.1 and try to complete the missing parts.

Table 7.1 – Cell Address – Table to be Completed
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Let’s Enter Data in Calc.
The Calc software window and its main tools have already 
been explored. Now, let us enter the income and expense details 
from Figure 7.1 as a table in a Calc file. 

Take a look at the same table prepared in Calc by a student 
named Anu (see Figure 7.4).

Cell Address
Cells are the squares in which 
information is entered.

If you click with the mouse 
on any cell, its address will 
appear in the column in the 
left corner.

Fig. 7.3 Cell Address

Fig. 7.4  Table Prepared in LibreOffice Calc

When the table was prepared as in Figure 7.4, aren't the figures 
clear and the analysis easy?

You might have noticed that the sizes of some cells were different. 
Similarly, some cells were merged into a single cell. Colours 
were also applied to the cells and text.

Now, collect the income and expense details of your family for 
the past five months and create a table in Calc in the same way.
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Adjust the size of the cells as shown in the figure. Merge the 
required cells and apply colours where necessary.

A table containing Manu's family's five-month income and 
expenditure accounts has been provided in the School_Resources 
folder under Home. You may use the data from that file if required.

Once the table is prepared, give it an appropriate name and save 
the file.

You have already learned how to adjust the size of cells in 
LibreOffice Calc in Class 7. When cells need to be combined, 
the Cell Merge feature should be used.

To Merge the Cells

	� Select the cells to be merged by 
dragging across them (Figure 7.5). 

	� Then, click the Merge and centre 
or unmerge cells button on the 
Formatting toolbar.

	� With this, the selected cells will be merged, 
and the data in the first cell will be centred 
within the merged area. Fig. 7.6 Cell Merge Tool 

Fig. 7.5 When Cells are Selected

We have just merged the cells using the Cell Merge tool from 
the toolbar. Now, explore and check for yourself if there are 
any other ways to select and merge cells.

Meenu’s family’s income and expenditure details have already 
been entered into the Calc sheet. Now, find out the method 
to calculate the total expenditure under each category for the 
family.

Finding the Total Family Expenditure
The total monthly expenditure of a family is the total amount 
spent on various items, isn't it? To calculate this amount, we 
have learned that the ‘Sum’ function in Calc can be used.

Try to find out the total expenditure for the month of June alone 
from this table using the Sum function. 
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Finding the Sum

	� To calculate the total amount for the first month (June), select 
the cell where the sum should be displayed (as shown in 
Figure 7.8, B11). 

	� Click the Σ (Select Function) symbol next to the cell address (Figure 7.7).
	� Select Sum from the drop-down list. (When you do this, the cells in that row will be selected 

automatically. In the cell where the total is displayed, you will see the name of the function 
followed by the cell range in brackets (Figure 7.9).

Fig. 7.7 Select Function

Fig. 7.8 Select Function Dropdown List

Fig. 7.9 How to Find the Total Amount

	� Then, press the Enter key. Now the total expenditure for the month of June has been obtained. 
	� Save the file by naming the row with the total amount Total.
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Also check if there are other ways in LibreOffice Calc to 
calculate the sum of numbers. The total expenditure for the 
other months also needs to be calculated in the same way. 
For this, it is sufficient to repeat the same steps in the other 
cells. However, instead of repeating the steps each time, is 
there any other method that can be used?

In spreadsheet software, there is a feature that allows you 
to copy the function obtained in a cell to other cells after 
calculating the sum. This method is called the Fill Handle.

The steps to copy a function using the Fill Handle are given below.

	� Select the cell that contains the function.

	� Click the Fill Handle icon (Figure 7.10) at the bottom right corner of the selected cell.

	� Drag it across the cells where you want to copy the function.

In this way, the function will be copied into all the selected cells. The cell references 

will automatically adjust according to their new positions.

Fill Handle

In spreadsheet software, the 
Fill Handle is a feature that 
helps you copy functions 
or data from a cell across a 
range of cells. The small “+” 
symbol seen at the bottom 
right corner of the selected 
cell is called the Fill Handle 
(Figure 7.10).

Fig. 7.10 Fill Handle

What would you do if you wanted to find the average of the 
amounts this family spent in various categories over five 
months?

Examine the table we are currently using. Is there any method 
in LibreOffice Calc to do this?

Finding the Average Amount

We have already understood that the average is found by 
dividing the total of all the numbers by the number of items / 
numbers. In Calc, there is a way to do this directly using the 
function.

Using the Average function in LibreOffice Calc, find the 
average expenditure for each item in each month.

After finding the average for the first item (Groceries), use the 
fill handle to calculate the averages for the remaining items.

Using Fill Handle to Copy a Function
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After calculating the averages for the remaining items, calculate 
the average of the family’s income over the five months as well.

Record the steps you used for this process in your notebook.

Finding the Average of Numbers

	� Click on the cell where the average should appear (here, G5).

	� Click on the cell where the average should appear (here, G5).

	� Next, press the Enter key. Now, the average of the amounts spent on groceries over the five 
months has been obtained.

	� Use the fill handle to calculate the averages for the remaining items.

	� You can give the column where the averages are recorded (Column G) the heading Average.

Fig. 7.11 How to Calculate the aAverage

While calculating the averages, it can be noticed that some of 
the amounts appeared with decimal places. Next, see how to 
remove the decimal places and convert the amounts into whole 
numbers.

Adjusting Decimal Places
To adjust or remove the number of decimal places, we can use the 
Delete Decimal Place option in the Formatting toolbar (Figure 
7.12).

Once the decimal places have been set in the first cell, the same 
formatting can be copied to the other cells using the fill handle.. Fig. 7.12 Delete Decimal Place Symbol
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Find out by trying what the Add Decimal Place option, located right 
next to Delete Decimal Place, is used for.

Let’s Format the Table
To find out which item had the highest expenditure over the five 
months, it is enough to sort the average expenses for each item 
shown in the table either in ascending or descending order. Try 
doing this using the Sort option in Calc.

Sorting the Data

	� Select all the data in the table that need to be sorted (Figure 7.13). Do not include the Total 
row here.

	� Select Data → Sort (Figure 7.13).
Fig. 7.13 Sort Window

	� In the Sort Key 1 field, 
select the column name 
(Figure 7.14) on which 
you want to sort (Column 
G since it is based on 
average cost).

	� Select the required 
option from Ascending / 
Descending (here, select 
Descending).

	� Click OK. Fig. 7.14 Sorting the Data
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Look at Figure 7.15. What changes can be seen in the table?

	� A title has been added to the table..

	� The title has been aligned to the center.

	� Borders have been applied to the cells in the table.

	�  A new row has been inserted below the heading Expenditure, 
and subheadings have been added.

	� ...............................................................................................

	� ...............................................................................................

Shall we try making similar changes to our table as well?

Using the formatting techniques learnt in earlier classes, format 
the table in the way shown in Figure 7.15. The tools for this are 
also available in the Format menu.

Meenu aims to analyse the family expenses and to control any 
excessive spending. For this, it is necessary to compare and 
examine the expenses in different categories. Such comparisons 
can be understood more easily if they are presented using 
charts and graphs. LibreOffice Calc provides the tools required 
for this.

Formatting the Table

Fig. 7.15 Formatted Table
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Charts/Graphs to Make Data Analysis Easier  
Using the data from the table you prepared, try creating a chart 
as shown below.

The prepared chart can be moved and placed in the appropriate 
location in the table.  

Presenting Data in the Form of Charts

	� Select the cells containing the 
information to be included in 
the chart (Figure 7.16). (Here, 
the cells under the Expenditure 
category have been selected, 
excluding the Average and Total 
cells.)

Fig. 7.16 Data to be included in the graph

ചിിത്രംം 7.17 Insert → Chart 

Fig. 7.18 Chart Properties Window

Fig. 7.19 Window for Setting Chart Elements

	� From the Insert menu, select Chart (Figure 7.17).

	� In the window that appears, choose Chart Type → 
Column (Figure 7.18).

	� Click Chart Elements and enter the required 
names for the Title, X axis, and Y axis (Figure 
7.19).

	� Press the Finish button.
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 Fig. 7.20 Completed Graph

Have a look at the prepared graph (Figure 7.20). With the help 
of the graph, it is much easier to analyse the details than by 
using the table of figures. What conclusions can be drawn?	

	� In the categories of Entertainment, Utilities, and Healthcare, 
there was a significant increase in spending in the fifth 
month.

	� The highest amount was spent on Groceries.

	� The Healthcare category had the lowest expenditure in 
September.

	� ...............................................................................................

	� ...............................................................................................

Find out which of these expenses can be controlled.

So far, we have created a chart using data from adjacent 
columns.

However, it is also possible to create a chart that includes only 
the information from the required columns and rows.

Create a chart that includes only the rows showing the total 
expenditure (Total) and the names of the newly added months 
in the table you have prepared. To select only the required 
rows, hold down the Control (Ctrl) key while selecting.

Spreadsheets help us analyse data, reach conclusions, and 
make appropriate decisions.

Graphs and charts 
make it easier to 

analyse data.
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Let's Assess

	 Which of the following functions is used to find the sum of numbers in Calc?

		  a) =ADD(A1, B1)				    b) =SUM(A1, B1)

		  c) =PLUS(A1, B1)				    d) =SUM(A1:B1)

	 Which function is not available in the Select Function (Σ) menu in LibreOffice Calc?	

		  a) SUM						     b) AVERAGE		

		  c) SUBTRACT					    d) MAX

	 Why is the symbol  in the formatting toolbar used in LibreOffice Calc?

		  a) To remove decimal places			   b) To add decimal places 

		  c) To find the average				   d) None of these

Extended Activities

1.	 The sales data for a day in the school store are provided below. Using this data, find out the 
total sales amount for that day with the help of LibreOffice Calc.

Hint: To find the total sales of each item for that day, simply multiply the quantity sold by 	
the unit price.



Data Analiysis on a Computer

35 Information and Communications Technology-VIII



2.	 Collect the height (in metres) and weight (in kilograms) of all the students in your class and 
create a table in LibreOffice Calc. Using the table, calculate the BMI (Body Mass Index) of 
each student. Sort the table so that the student with the highest BMI appears first.

	 (Hint:BMI = Weight in kilograms / (Height in metres)²)

3.	 Collect information about how your classmates travel to school—whether by bicycle, by 
other vehicles, or on foot. Create a table in LibreOffice Calc with this data. Then, prepare a 
pie chart to show the number of students in each category.
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Chapter 8

Fun with Learning Science
The progress and development of science are fundamentally 
based on experiments and observations. In ancient times, the 
foundation of science was built upon knowledge that humans 
acquired directly from nature. Today, the rapid advancement of 
information technology is bringing revolutionary changes to 
scientific studies and research.

Every discovery and breakthrough serves as a stepping stone 
to the next phase of scientific progress. In today's digital age, 
information and communication technology has influenced 
every field. In scientific research, Virtual Labs which assist 
in conducting everything from simple experiments to highly 
complex ones are now widely used.

Today, numerous technologies are available to make science 
learning easier and more interesting. Virtual labs, simulation 
software, digital maps, and 3D modelling software help us 
understand molecular structures and chemical reactions, 
interactive geometry software and similar tools are now widely 
used in educational activities. Let's explore some operations 
using such software.
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SUNCLOCK
Sunclock is a free digital map software that visually distinguishes between countries 
experiencing day and night by displaying them in shaded and lit areas. It provides various 
time zones, distances between regions, as well as geographical coordinates (latitude and 
longitude) of each location.

The Sunclock software was developed by French mathematician Jean-Pierre Demailly.

8.1 The Marvels of Time

Did you know that the first place on Earth to welcome the 
New Year is New Zealand? When it's December 31 midnight 
(12 AM) in New Zealand and they celebrate New Year, do 
you know what time we in Kerala would be watching its live 
broadcast?

How can we find this out?

You're probably aware that different countries follow different 
times. Similarly, you may have heard about time zone maps 
that accurately show time differences across regions. The 
'Sunclock' software on our computers also includes a time zone 
map.
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Fig. 8.1 Sunclock Window

Why not use Sunclock software to check the time difference 
between New Zealand and India?Time Zones

Greenwich is a line that 
is defined by considering 
Greenwich, London, as 0° 
longitude and defining its two 
sides as east and west.

The world is divided into 24 
time zones, each with a time 
difference of one hour, based 
on the Greenwich Mean Time. 
These are known as time 
zones.

As you've learned in social science class, time across the world 
is determined based on the Greenwich Meridian. 

Let's see how to use Sunclock software to view the time 
difference between two locations in different time zones. The 
Sunclock software has specific tools configured for each of its 
functions.

Solar Time and Legal Time
The time determined based on the sun's highest position (zenith) at any particular location is 
called Local Time. In Sunclock software, you can view a place's local time by using the Solar 
Time Mode (the 'S' tool in the toolbar).

If time is calculated based solely on local time, even within a single country there would be 
different times. To overcome this problem, countries typically adopt the local time of the 
longitude passing through their central region as the common time for the entire nation. This 
commonly calculated time is called Standard Time.

In Sunclock software, you can determine a location's standard time by using the Legal Time 
Mode (the 'L' tool in the toolbar).

To check the time difference between two countries using 
Sunclock software, follow these steps:

	� Open the Sunclock software and display the world map with 
marked time zones.

	� Enable the latitude/longitude grid lines and their 
corresponding values for reference.
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	� Find the legal time in both locations and find the difference 
between them.

Fig. 8.2 Sunclock Menubar

	� If you click on the map in SunClock, the toolbar will appear.

	� Open the time zone map by clicking on the Clock & Map Window (!) tool in the menu bar.

	� Click once on the Draw/Erase Meridian Tool (M) to display the longitudinal lines. Clicking 
it again will display the values   along with the longitudinal lines..

	� You can convert the time to standard time by clicking on the legal time mode (L).

	� Click on the location where you want to see the time (e.g. Calcutta) and the software will 
display the time and date of the selected location in the lower left part of the window (the 
time for each location should be displayed only after converting to standard time).

Calculate the time difference between Auckland in New 
Zealand and Kolkata in India, and complete the table given 
below.

City (Country) Date Time  
(24 hr.)

The time difference between 
Kolkata and Auckland

Kolkata (India)
................ hour 
................ minute

Aukland(New 
Zealand)

Table 8.1 Time Difference between Two Places

Similarly, the time in other cities may be different.

Using the map given in Figure 8.3, identify the marked cities 
and calculate how many hours their local time differs from 
Greenwich Mean Time (GMT). Then, complete Table 8.2 
accordingly. Note that the time difference from the Greenwich 
Meridian is also indicated at the bottom of the time zone map.
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Fig. 8.3 Time Zone Map in Sunclock

City Date Time
Difference from Greenwich Mean Time 

(GMT) (in hours -more/less)

Anchorage

Mexico City

Rio de Janeiro

London           0 hour

Rome

Cairo

Moscow

Tehran

Beijing

Tokyo

Table 8.2 Time Differences at Various Places

As you've observed from the table, time increases when moving 
eastward from the Greenwich Meridian, and decreases when 
moving westward. Haven't you wondered why this happens?



Fun with Learning Science

41 Information and Communications Technology-VIII

Time from Sunrise to Sunset
As you know, the Earth rotates from west to east, which is why 
the sun rises earlier in eastern countries and sets there first. But 
does the sun rise at the exact same point on the eastern horizon 
every day of the year?

Actually, the position of sunrise changes throughout the year. 
During some months, the sun rises slightly north-east of its 
usual position, while in other months, it shifts slightly south-
east.

Have you noticed how this affects the length of day and night 
during these months?

Using Sunclock , determine the sunrise and sunset times for 
Mumbai across different months. Record any variations in day 
length (duration of daylight) in Table 8.3.

To find sunrise/sunset times, follow these steps in Sunclock. 
Adjust the settings as specified below. Tool names are indicated 
in brackets.

	� Display day/night division (N).

	� Show the sun (Y).
	� Display standard time (L)
	� Adjust time and date:
	G - Change time increment rate

	A - Move time forward

	B -  Move time backward

	� Select location (here Mumbai city) for sunrise/sunset times

Fig. 8.4 Night and Day in Sunclock
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	� Run the animation to identify when daylight first appears 
over the marked city location. This time is the city’s sunrise 
time.

	� Stop the animation when daylight fully disappears over the 
marked city. Note the time displayed at the bottom of the 
window—this is the city’s sunset time.

	� Press the single quotation mark (') key on your keyboard to 
start/stop the animation.

Date Sunrise Sunset Duration of Day (Hour, Minute)

December 22

March 21

June 21

September 23
Table 8.3 Duration of Day in Mumbai at Different Times

Have you noticed how the length of day and night changes 
according to the dates? Why do you think this happens?

Using Sunclock, identify which latitude lines the Sun is directly 
overhead on the given dates below. Record your findings in the 
table given.

Date Position of Sun ( Latitudinal line)

December 22

March 21

June 21

Septermber 23

Table 8.4 The Days when the Sun is Directly Overhead (Vertical) on the 
Latitude Lines

On December 22nd, the Sun is directly overhead the Tropic 
of Capricorn (Southern Hemisphere). It then moves northward 
and reaches the Tropic of Cancer (Northern Hemisphere) by 
June 21st. After this, it reverses its path.

This apparent north-south movement of the Sun between 
the two tropics is known as the Solar Declination or Ayana 
(Solstice Shift).
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 The Sun’s Apparent Movement (Ayana)
The Sun’s position shifts between the Tropic of Cancer 
(Uttarayanam) and the Tropic of Capricorn (Dakshinayanam) 
due to the constant tilt of Earth’s axis during its revolution. 
This apparent movement of the Sun is called Solar Declination 
or Ayana.

The Sun’s northward journey from the Tropic of Capricorn 
to the Tropic of Cancer is called Uttarayanam (Northern 
Solstice), while its southward journey from the Tropic of Cancer to the Tropic of Capricorn is 
called Dakshinayanam (Southern Solstice)

The Relationship Between the Sun’s Apparent 
Movement (Ayana) and Day Length
Now let’s see how the Sun's apparent movement (Ayana) and 
the length of daytime at different locations are related?

	� On March 21 and September 23, the Sun's position is directly 
above the Equator.

	� From March 22 to September 22, the Sun's position is above 
the Northern Hemisphere.

	� From September 24 to March 20, the Sun's position is above 
the Southern Hemisphere.

To understand the relationship between the Sun's apparent 
movement and daytime duration, one can compare the length 
of daytime in various cities during different seasons.

That is, it's sufficient to observe the day length during days 
when the Sun is positioned above the Tropic of Cancer, Tropic 
of Capricorn, and the Equator at different times of the year.

To examine the Sun's Apparent Movement (Ayana) in Sunclock Software:
Open the Sunclock software and maximize the window, then enable the menu bar. Afterwards, 
make necessary adjustments using the tools listed below:

	� Use the Draw/Erase parallel [P] tool to display latitude lines and measurements.  

	� Use the Draw/Erase Tropics/Equator/Arctic circle [T] tool to make visible  Tropic of Cancer 
and Tropic of Capricorn (Northern and Southern solstice lines),The Equator, The Arctic and 
Antarctic circles

	� Toggle Night [N]- Display the separation between night and day.

	� Toggle Sun/Moon [Y] - Make the Sun visible.
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	� Use the Adjust Program Value tool (G) to change the rate of time change. [Set the progress 
value to 1 day]

	�  Then activate the animation tool. You will be able to observe the Sun's apparent movement 
(Ayana) caused by Earth's revolution.

Fig 8.5 Sunclock Window

Now, find the duration of day and night at the locations marked 
in Figure 8.5 and complete Table 8.5.

Location Country
Latitudinal 

position

When the Sun's position 
is in the Northern 

Hemisphere, 
the duration of day

When the Sun's 
position is in the 

Southern Hemisphere, 
the duration of day

Thule Greenland Artic Circle

Kolkata
India Near Tropic of 

Cancer
Increases Decreases

Kuala Lumpur Malaysia Near Equator

Sydney
Australia Near Tropic of 

Capricorn

Erebus Antartica Antartic Circle

Table 8.5 The Changes in Daytime Duration across Various Regions According to the Sun's Position.
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From the table, you’ve now understood how day-night 
duration varies across different locations, haven’t you?
	� During Uttarayana (Northern Solstice): At Thule 
daytime duration increases while night-time duration 
decreases.

	� During  Southern Solstice: At Thule: daytime duration  
........................................................................................
........................................................................................

	� During Northern Solstice: At Erebus  daytime duration 
........................................................................................
........................................................................................

	� During Southern Solstice: At Erebus daytime duration 
........................................................................................
.......................................................................................

Let'd Evaluate

	 What is the time difference between Anchorage and Tokyo?

		  a) 18 hours		  b) 19 hours		  c)  20 hours		  d) 21 hours

	 In the Sunclock software, which setting is NOT required to find the sunrise time in Mumbai?

	 a)	 Click on the Toggle Night (N)tool.

	 b)	 Click on the Toggle Sun/Moon (Y)tool.

	 c)	 Click on the Switch Clock & Map Window (!)tool to adjust the map view.

	 d)	 Activate the Animation (‘) tool.

	 Which tool should be clicked to open the time zone map in Sunclock software?

	 	 a)  N			   b)  Y			   c)  I		  d)  ! 

Extended Activities

1.		 Using the Sunclock animation, identify and write down the dates when the Sun is directly 
overhead (at zenith) along the 100°E longitude line that passes through Kerala.

2.	 Using Sunclock, determine the duration of daylight on June 21 and December 22 in 
Anchorage, Alaska.
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8.2 Chemistry of sweets

Everyone loves ice cream, right? There's a special desire for sweet things.

Sweet foods are also energizing. Have you ever seen children who are tired after participating 
in sports events being given sweet glucose supplements?

A spoonful of glucose and a pinch of glucose are both sweet. Even the smallest particle we can 
see, and even the smallest particle that is ground to the smallest, will still have the properties of 
glucose. We have learned from science classes that the smallest unit that contains the properties 
of a substance can be described as its molecule.

The study of the molecular structure of each substance 
and the particles involved in it is an important activity in 
science classes. There are many ways to study molecules, 
one of which is the study based on molecular models. 
This helps a lot in understanding the basic concepts 
related to molecular structure. Avogadro, Chemsketch, 
PyMOL, PhET software are used for studies in this 
field. Here, with the help of simulation software such 
as Avogadro and PhET we discuss how to understand 
molecular structure .

Avogadro

Avogadro is a molecular editing 
software that helps create three-
dimensional models of molecules. 
It is maintained and distributed 
under the leadership of the Open 
Chemistry Project.
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Let's Build Molecular Models
Have you ever wondered what the shape of molecules would 
be? Do the molecules of all substances have the same shape? 
Let’s try making molecular models using Avogadro software.

First, let's make a model of a water molecule.

How much hydrogen and oxygen are there in a water molecule?

The chemical formula of a water molecule is H₂O. It contains 
two hydrogen atoms and one oxygen atom. Let's see how we 
can model this with the hydrogen atoms bonded to the oxygen 
atom.

The water molecule is 
formed by the combination 
of hydrogen and oxygen.

How to Draw Molecular Structure in Avogadro Software

	� Open Avogadro software.

	� Select the Draw tool from the toolbar.  

Navigation
Draw

Fig. 8.6 Avogadro - Toolbar

	� Select the element to 
be included first (here 
Oxygen) from Element.

	� Remove the tick mark 
from Adjust Hydrogen.

	� Then click on Canvas and 
include oxygen.

	� Select the second element (here hydrogen) from Element.

	� Click and drag the first oxygen you added to the Canvas to connect it to the hydrogen. Add 
one more hydrogen.

	� To equalize the bonding and spacing between elements, select Extensions → Open Babel 
→ Optimise Geometry from the menu bar.

	�  Tick Labels in Display Types to make labels visible.

	�  Save the prepared model ( File → Save ).

The structure of a water molecule is shown in Figure 8.7, 
prepared in Avogadro software. Zoom in on the molecule using 
the navigation tools and mouse, and view it from the sides. Is 
the structure of the water molecule not clear?
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Fig. 8.7 Structure of Water Molecule in Avogadro Software

Now, try preparing carbon dioxide (CO2) molecule in the same 
way you prepared water molecule.

Navigation in Avogadro
The molecules in the Avogadro software are arranged in a way that gives a three-dimensional 
view. The molecules arranged in this way can be viewed from many directions. To do this,

	� elect the Navigation tool..

	� ou can rotate by pressing the left mouse button and moving the mouse.

	� You can adjust the view in the direction you move the mouse by pressing the right mouse 
button..

	� You can zoom in and out by moving the mouse scroll wheel back and forth.

The Recipe Glucose
We initially discussed the glucose molecule. Let's look at the 
structure of the glucose molecule using Avogadro.

To prepare molecular models in Avogadro, you need to 
know what elements are present, how many of each element 
are present, and how they are related to each other. Instead, 
you can use pre-prepared models  to understand molecular 



Fun with Learning Science

49 Information and Communications Technology-VIII

structure. Let's examine how to use such models provided in 
the Avogadro software.

Let's look at a model of a glucose molecule.

To Obtain the Molecular Structure of Glucose in Avogadro

	� Select Build → Insert → Molecule In the Insert Fragment window that opens (Figure 8.8), 
type Glucose in the Filter field.

	� Select d-glucose.cjson under carbohydrates and press the Insert button..

	� This gives the structure of the glucose molecule (Figure 8.9).

Fig. 8.8 The Model File of Glucose 
Molecule Selected in Avogadro

Fig 8.9 The Structure of Glucose Molecule 
in Avogadro Software

Haven't you observed the structure of the glucose molecule?

What elements make up the glucose molecule?

To do this, after displaying the labels of the elements, look at 
the label (Figure 8.10) and find the name of the elements and 
write it below.

Fig 8.10 Structure of Glucose molecule-
Label shown

	� Hydrogen

	� ..............................................................................

	� ..............................................................................

	� ..............................................................................

Then complete Table 8.6 given below.
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Molecule

No of atoms

Hydrogen Oxygen Carbon

Glucose

Table 8.6  Details of Glucose Molecule

Avogadro's Periodic Table

If you cannot identify an element by looking at the label, you can use the periodic table 
provided in the Avogadro software. It contains the names of the elements along with their 
symbols.

To get the periodic table, simply select Extensions → Periodic Table from the menu bar.

Different Aspects of Water
You've seen the molecular structure of water and glucose. 
Have you ever thought about the size of their molecules? Think 
about how many molecules there are in a glass of water. How 
would these molecules be arranged?

Simulation software such as PhET can be used to understand 
molecular arrangements. The simulation States of Matter: Basics 
available on PhET can be used to understand the molecular 
arrangement in water. To do this,

	� Open PhET.

	� Search for States of Matter.

	� Select States of Matter: Basics. Open.

	� Select Water from Atoms & Molecules (Figure 8.11).

First, select Liquid and understand the distance between 
molecules in water and their movement.

PhET is a collection of science and math simulations. The project 
was designed by Colorado Border University under the leadership 
of Nobel Prize winner Carl Wieman.
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Fig. 8.11 States of Matter: Basics window

Is there any change in the nature or arrangement of these 
molecules in the solid state of water, ice, and the gaseous state, 
steam?

Replace Liquid with Solid and Gas one by one, observe the 
molecules and complete Table 8.7 below.

Matter Distance between Molecules Movement of Molecules

Ice(solid state)

Water (Liquid state)

Vapour(Gaseous state)
Tabel 8.7 Behaviour of Water in Various States

Does the arrangement of molecules change with temperature?

Changing the temperature changes the state of matter. Consider 
the case of water.

What is to do to turn water into ice?

To make steam?

 To understand the changes in the arrangement of molecules 
as the temperature of water changes, select the Liquid state 
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in States of Matter: Basics . Prepare note  after observing the 
changes in the water molecules  when temperature is increased.

Let’s Evaluate

	 The molecular structure shown in the image was created using Avogadro 
software. What substance is this structure of?

	 a)  ZnCl 			   b)  Zn 			  c)  Cl		  d)  ZnCl2

	 Organize the activity of preparing the molecular structure of ammonia (NH) using Avogadro 
software.

	 A)	Click and drag on the nitrogen atom to insert hydrogen atoms.

	 B)	 Select Element- Hydrogen.

	 C)	 Select Element- Nitrogen. Add it to the canvas.

	 a) A, B, C			   b) B, C, A	 	 c) C, B, A 	 d) A, C, B

Extended Activities

1.	 	Prepare the molecular structures of oxygen (O2), fluorine (F₂), sodium chloride (NaCl), and 
ammonia (NH3) using Avogadro software.

2.	 Display the molecular model of methanol in Avogadro software and understand which 
elements are included in it and how many atoms of each element there are.

8.3 Making Geometry Learning Fun

Since ancient times, geometry has been an integral part 
of human thought. From measuring distances—such as 
those between stars or the size of Earth—to modern space 
exploration, geometry has been a vital tool. Even today, it 
remains essential in scientific fields like astronomy, design, 
architecture, and urban planning. With advancements in 
information technology, the practical applications of geometry 
have expanded significantly.
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Software like GeoGebra is widely used for teaching and 
presenting geometric concepts in geometry studies, as you 
know. Such applications make learning geometry easier and 
more interesting.

You have already learned how to construct geometric shapes 
using GeoGebra software in previous classes.

Look at the shape given in Figure 8.12. How can we draw such 
a shape?

In the given design, three circles of equal size are arranged 
inside another circle.

Let’s examine how this can be constructed. For this:

	� Draw a circle.

	� Draw three circles of equal distance passing through the 
centre of the first circle.

What is the method to draw circles at equal distances in this 
way?

	� The vertices of an equilateral triangle are at equal distances, 
right? We can draw a larger circle passing through the 
vertices of the equilateral triangle.

	� This design can be completed by drawing three smaller 
circles that pass through the centre of the larger circle and 
each vertex of the equilateral triangle.

Let’s see how to construct this using GeoGebra.

Three Points and Circle
The first step in constructing the design is to draw a circle 
passing through the vertices of an equilateral triangle.

How can you draw an equilateral triangle?

Recall the Regular Polygon tool you learned in previous 
classes and use it to draw an equilateral triangle (Figure 8.14) 
in GeoGebra.

Fig. 8.12:  Design Using Circles.
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Using the Regular Polygon Tool to Draw Polygons
To draw a polygon using GeoGebra's Regular Polygon tool:

	� Select the Regular Polygon tool from the fifth toolbar set.

	� Click on the workspace and drag to create one side. This will open the window shown in 
Figure 8.13.

	� In the Vertices field, enter the number of sides for the regular polygon (here, "3" is entered 
for  triangle).

Fig 8.13 Window to Enter the Number of Sides while 
Using the Regular Polygon Tool

Fig 8.14 The Equilateral Triangle Drawn 
Using Regular Polygon Tool  

How can you draw a circle passing through the vertices of this 
triangle?

	� Find a point equidistant from all three vertices of the 
triangle. Using this point as the centre, you can draw the 
required circle.

As you may know, this can be achieved by drawing 
perpendicular bisectors of the triangle's sides.

Which tool can be used for this purpose? Investigate.

Labels Can Be Removed
In GeoGebra, if you start drawing after closing the Algebra 
View, you can exclude labels for the included objects.

Fig 8.15 Geogebra – Algebra View
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To draw Perpendicular Bisectors in GeoGebra

	� To draw a perpendicular bisector in GeoGebra, select the 
Perpendicular Bisector tool from the fourth toolbar set, then 
choose the sides of the triangle for which you want to draw the 
bisectors.

	� To mark their intersection point, use the Intersect tool from the 
second toolbar set and sequentially select the perpendicular 
bisectors (Figure 8.16).

Fig. 8.16 The intersection point 
of the perpendicular  bisectors 

of the sides of  the trangle

Haven't we already drawn the perpendicular bisectors of the 
sides?

Now, construct a circle passing through all three vertices of the 
triangle. Which tool should be used for this?

Try drawing the circle using the Circle with centre through 
Point tool that we learned in 7th grade. Circumcircle

A circle while passes through 
three vertices of a triangle is 
called circumcircle.

Fig 8.17 Circle Passing through the Vertices of the Triangle

You have now understood how to draw the circle passing 
through all three vertices of the triangle (Figure 8.17).
Now we can temporarily hide the perpendicular bisectors we 
drew.To do this, right-click on the construction you want to 
hide and examine the menu that appears.
GeoGebra also has a tool to draw circumcircles without 
constructing perpendicular bisectors. Check the tools in the 
sixth group and identify the appropriate tool, then write its 
name below.

...........................................................................................

The first stage of our construction is now complete. Next, 
let's examine how to arrange the smaller circles to be included 
within the main circle.

Hiding Objects
To hide an object in 
GeoGebra: Right-click 
on the object Remove the 
tick mark from → Show 
Object.
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	� If we find the midpoints of the triangle's sides inside the 
circle, we can easily draw the smaller circles (Figure 8.18).

To Find the Midpoint
To locate the midpoint of a side: Use the Midpoint or centre 
tool from the second toolbar set.  Click on the side of the 
triangle.

Fig. 8.18 Midpoints of the Sides 
of the Triangle Using the Midpoint or centre tool, haven't you already marked 

the midpoints of all sides of the triangle?

Now, let's draw the smaller circles.

We need to draw a circle (Figure 8.19) that passes through 
one vertex of the triangle and the midpoints of the two sides 
connected to that vertex.

Examine the set of tools for drawing circles. Using the 'Circle 
through 3 Points' tool, as shown in Figure 8.19, try drawing 
a circle that passes through one vertex of the triangle and the 
midpoints of its sides.

Now you can easily add the other two circles (Figure 8.20).

Now complete the design by colouring the circles in the image 
(Figure 8.21). Then, you need to hide the unwanted shapes as 
shown in the image.

Fig. 8.19 Circle that Passes through 
One Vertex of the Triangle and the 

Midpoints of its Sides. 

Adding Colour
To apply colour to an object: Select the object,Right-click 
→ Choose Properties. In the window that appears, select 
the desired colour from the Color tab, Adjust the Opacity 
as needed.

Fig. 8.20 Circles that Pass through 
Vertices of the Triangle and the 

Midpoints of its Sides.

Circles and Triangles
You have now learned how to 
draw the circle passing through 
the vertices of an equilateral 
triangle , that is  its circumcircle. 

Fig. 8.21 The Design when 
completed
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Save the file, 
ok

To Draw a Triangle with Specific Angle Measures

Fig. 8.22 To Draw an Angle with 
Given Size  Fig. 8.23 angle with given size

	� Using the Angle with Given 
Size tool from the eighth 
toolbar set, mark two points 
(figure 8.22).

	� Enter the angle measure in 
the window that appears.

	� Then, use the Polygon tool to 
connect the three points and 
complete the triangle (Figure 
8.23).

Dynamic Triangle
In 7th grade, we learned to use the Slider tool to draw multiple 
concentric circles around a centre point. Can we use the Slider 
tool to control the angle measures of the triangle?

After creating an Angle Slider, use its assigned variable to 
draw a  triangle.

What if we draw circumcircles of scalene triangles? We can 
also examine the relationship between the triangle and the 
position of its circumcentre.

In GeoGebra, what methods exist to draw triangles?

	� Using the Polygon Tool

	� Using the Regular Polygon Tool

	� ...............................................................................................

	� ...............................................................................................

But how can you draw a triangle with specific angle measures?

For example, let's see how to draw a triangle with one angle of 40°.

Try the method shown below.
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To Control the Angles of a Triangle Using a Slider in GeoGebra

Step 1: Creating an Angle Slider 

	� Click on the Slider Tool (10th tool in the 
toolbar) and then click on the desired location 
in the workspace to place the slider.

	� In the slider window that appears, select the 
Angle option.

	� Set the minimum value to 50, maximum 
value  to 1750, and increment to 50, then 
click OK (Figure 8.24).

Step 2: Constructing the Triangle

	� From the 8th toolset, select Angle with Given Size (Figure 8.25).

	� Enter the variable name assigned to the slider as the angle.

	� Press the OK button to confirm.

	� Plot the angle and use the Polygon Tool to complete the triangle (Figure 8.26).

Fig. 8.24 Slider Window

Fig. 8.25 Angle with Given Size-  
Window to Give Angle Measurement

Fig. 8.26 Triangle that Changes  
According to the Slider Measurement

Using the slider, we've now created an adjustable triangle, right?

As you move the slider, triangles with different angle measures 
appear, correct?

Now let's see how we can mark and display the measurements 
of the other two angles in these triangles.
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Measuring Angles
	� To measure an angle, 

use the Angle Tool from 
the eighth toolset. Select 
three points in clockwise 
order, and the interior 
angle measurement will 
appear.

	� To get all interior angles 
of a polygon at once, 
simply click inside the 
shape using the Angle 
Tool (Figure 8.27).

Fig. 8.27 When Angles are 
Recorded

Circumcircle and Its Centre
Now that we've created the triangle, we can easily draw a 
circumcircle (a circle passing through all three vertices) using 
the Circle through 3 Points tool.

Finding the Centre of an Object

	� To find the centre of a shape 
prepared using the Polygon tool: 
Select the Midpoint or centre 
tool. After selecting, click inside 
the shape.

	� To find the centre of a circle: 
Click on the circumference of 
the circle (Figure 8.28). Fig. 8.28 When Angles are 

Recorded

After finding the centre of the circle, 
adjust the value in the slider to create 
triangles of different sizes. Observe 
how the position of the circle's centre 
changes as you modify it. Then, fill 
in the given Table 8.8 accordingly.

Measurements of Triangle Position of the Centre 
of Circle

All three angles are less than 90o. Inside the triangle

One angle  90o

One angle more than 90o

Table 8.8 The Features of Circumcircle
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Let's Mark the Movement of the Chords
In the construction we've just prepared, the sides of the triangle 
act as chords of the circumcircle. Here, try moving one angle 
and observe its path using the trace function.

You can create beautiful patterns this way.

Creating Pattern
The pattern is created  by moving chords within the circumcircle. For this purpose:

	� Include an additional Angle Slider (minimum value 0°, maximum value 360°, increment 
5°).

	� Using the Rotate around Point tool from the ninth 
toolset: First click on the circle's centre. Then 
click on one chord

	� In the window that appears, select the variable 
corresponding to your configured Angle Slider

As you adjust the slider value, observe how the 
chord's position changes

	� Right-click on the movable chord and enable 
"Trace On"

	� Now move the slider - this will generate the 
pattern shown in Figure 8.29 Fig 8.29 Pattern Obtained when Moving 

the Chords

Let's Evaluate

	 In the construction shown in the figure, which sequence 
should be followed to obtain the marked angle measurement?

		  a)  V, T, U 			   b)  U, T, V 		

		  c)  S, T, V			   d)  V, T, S

	 Which step is NOT part of the process to draw a circumcircle 
passing through both endpoints of a line segment in GeoGebra?

	 A)	Draw a small segment using the Segment tool

	 B)	 Find the midpoint using the Midpoint or centre tool	
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Extended Activities

1.		 In GeoGebra, construct a triangle with one side length of 8 
units and angles at its two endpoints as 40° and 50°, then 
draw a circumcircle passing through all its vertices.

	 C)	 Mark intersection points using the Intersect tool

	 D)	Draw the circle using "Circle with centre through Point" tool		  a) A		
	 b) B		  c) C 		  d) D

2. 	Create the patterns given below in GeoGebra.


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Chapter 9

Let’s Frame the Shots
'With the rise of social media platforms, anyone can now become a publisher. The gap 
between content creators and viewers has significantly narrowed. Through this medium, 
content covering all aspects of life—entertainment, music, technology, education, health, 
food, and more—has reached the masses. At the same time, it has also become a future career 
path, helping many achieve financial independence. According to 2025 estimates, India has 
approximately 80 million video content creators and 265 million viewers, with over 60% of 
them coming from rural areas. Even news channels have now transitioned into social media 
users. The biggest advantage is that any creative individual can rise to the position of a 
'Social Media Influencer' and drive major social changes through the videos they publish on 
these platforms’

The next episode's content for the school YouTube channel has 
been assigned to Hima and her team. After a detailed discussion 
on creating diverse video content, they decided to produce and 
publish an awareness video against the dumping of plastic 
waste in public spaces.
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Video Script
The script or screenplay holds great importance in video 
production. Whether it's a documentary, television program, 
YouTube video, or advertisement, the script forms one of 
the foundational elements of their excellence. This blueprint 
includes the scenes involved in video production , dialogues, 
visual descriptions, instructions on how to arrange visual 
elements etc.

A good video script creates a good video.

What all needs to be done to prepare such a video for publishing 
on social media? Let's examine:

	� The required script for the video must be prepared.

	� The video must be shot according to the script.

	� Necessary edits should be made using editing software.

	� ...............................................................................................

	� ...............................................................................................

Each of the above steps will have various sub-steps, right? 
Through the process of video production, let's analyse each one 
in detail.

Let's Prepare the Script
Just as any task requires precise preparation and planning to 
make subsequent steps easier, scriptwriting is an important 
preparatory step in video production. A script essentially means 
documenting all the details related to the video being planned 
in advance.

We are preparing this video to raise public awareness about the 
issue of plastic waste being dumped in public areas.

For the content video we're about to create,  prepare a script 
following the given template format (Table 9.1) after discussing 
with your friends.
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Table 9.1 Script -Model

Content Video Production Script - Template

Scene details Camera 
Shot

Sound/
Dialogue

Background 
music Time Remarks

Scene 1
The host looks 
into the camera 
and introduces 

themselves.

Close up 
shot

Hi, My name 
is Hima No 8-15 seconds

Scene 2
Shots of plastic 
waste scattered 
across public 

places

Mid-shot

Attention-
grabbing 

message about 
plastic waste 

crisis

Background 
Music 40-60 seconds

Scene 3

Scene 4

Isn’t the script ready? The script template provided in Table 
9.1 includes some camera-related details, right? Let's examine 
what these are.

Camera Usage Guidelines:
High-quality video clips are essential for producing premium 
content. Best cameras can significantly improve video clip 
quality.  Make use of  DSLR cameras made available in schools 
to high-end smartphone cameras – for this purpose.

Mobile Phone Camera and DSLR Camera
While DSLR cameras were previously dominant for shooting visuals, 
the rise in content creation has led to increased mobile phone usage
 as well. Both mobile cameras and DSLRs come with their own 

advantages and limitations. 
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Portability, ease of use, quick data transfer, and multiple 
lens options in a single device are key advantages of mobile 
phones whereas superior image quality, interchangeable 
lenses for specific needs, manual control settings, high-
quality audio capture, expandable storage options are the 
benefits of using DSLR camera.

Camera resolution is a key factor affecting the clarity of 
captured visuals. With the teacher's guidance, let's identify the 
video camera with the highest available resolution for shooting. 
The school's existing camera can also be used for this purpose.

Camera Resolution
Pixel is the smallest unit of digital image information. Multiple pixels combine to form a 
complete image. Camera Resolution refers to either the number of pixels on a camera's sensor, or 
the total pixels in a digital image . This is related to the image clarity. Image clarity increases 
as the number of pixels increases. The term 'megapixel' is the unit used to specify resolution 
in either photos or videos.

Shooting
For high-quality video recording, careful attention must be paid 
during shooting. Go through some important points given below 
before shooting your video.

 Mobile Video Recording
By paying attention to a few key factors, we can produce high-quality videos using just a 
mobile phone.

	� Keep Lenses Clean. Before shooting, gently wipe the lens with a microfiber/
cotton cloth

	� Ensure Camera stability. Use a mobile stabilizer or tripod to prevent shaky 
videos.

	� To optimize Audio Quality, shoot in a quiet environment to minimize 
background noise. Use an external microphone (if available) for clearer sound.  

	� Understand camera settings: Exposure, White Balance, Focus, etc. Mobile 
Stabiliser
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	� Exposure: The amount of light entering the camera sensor to 
create an image. Exposure can be controlled by adjusting aperture 
or shutter speed.

	� Artificial lights can be used to ensure proper lighting on the 
subject.

	� White Balance: Adjust this to ensure accurate colour tones in the 
visuals.

	� Focus: Adjust this to ensure clarity in the captured visuals.

In videography and photography, various camera techniques are 
used to make content impactful.

 For example, to effectively convey the severity of plastic pollution, 
we can use close-up shots of the affected areas. Similarly, to 
clearly show the amount of waste, we may use slightly wider 
shots that include both the garbage and its surrounding area.

These types of shots are captured through different camera 
angles. Read the caption below to know more about camera 
shots (Figure 9.1).

Camera Shots
The scenes captured between the camera being turned on and off are generally called a shot. 
Shots come in different types.

Close-up Shot
Medium Shot
Long Shot

Artificial Light

Fig. 9.1  Various Camera Shots
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Video Editing
Video editing is the process 
of cutting out unwanted parts 
from video clips and adding 
dialogue, background music, 
transitions, effects, and title 
clips to create a single video. 
Kdenlive, OpenShot Video 
Editor, Pitivi Video Editor, 
Final Cut Pro, and Adobe 
Premiere Pro are some of 
the popular video editing 
software.

We've discussed many important aspects to consider while 
shooting videos. Now, let's film the video according to the 
script and save it in a folder on the computer. Remember, the 
shooting process should be completed as a group activity...

Finished shooting? The next step is to edit the video clips stored 
on the computer and prepare the final content video.

What kind of modifications might we need to make to the 
footage we've shot for this purpose?

	� Cut and remove unwanted sections

	� Add appropriate background music

	� ...............................................................................................

	� ...............................................................................................

On to the Editing
Video editing is just as important as shooting and creating video 
clips. You can make your video more interesting by cutting out 
unwanted parts of the video, arranging the clips in an attractive way, 
and adding background music, transitions, and effects.

Let's take a look at how to edit video clips that we have shot and 
stored on our computer, using the video editing software  Kdenlive.

Kdenlive

Kdenlive is an excellent video editing application 
available under free software licenses. The first version 
of Kdenlive was released in 2002 by Jason Wood, an 
English software engineer. Kdenlive allows you to edit 
video and audio clips, add background music, create 
title clips, and export to various video formats.

Let's Get Familiar with Kdenlive
Open the Kdenlive video editing software on your computer 
and examine its various features with the help of Figure 9.2.
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Fig. 9.2 Kdenlive Video Editor Window

Let's Start the Video Project
Now that you're familiar with the Kdenlive software interface, 
let's see how to edit videos using it.

For this, the first thing to do is to start a project file. Videos 
prepared for different purposes require different quality. Therefore, 
while preparing a video project, we should configure the video 
resolution and frame rate matching our requirements. In the 
image (Figure 9.3), see the profile HD 720p 25 fps configured. 
In this way, you can select a video profile for your video and 
start the project.

Starting a Project in Kdenlive

	� Open Kdenlive software   

	� Go to Project Menu → Open Project Settings window.
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	� Select appropriate video 
settings preset (Example: 
HD 720p 25 fps)

	� Choose your project 
folder from Custom 
Project Folder

	� Click OK

	� Save your project giving 
a name: Use File → Save 
As

Fig. 9.3 Project Setting Window

Now that the video project is prepared and saved, let's import 
video files for editing into the software's Project Bin. Locate 
your collected video files and import them into the Project Bin 
(see Figure 9.4 for guidance)

To Add Video Files to the Project Bin

	� Click Add Clip or Folder in the Project Bin area.

	� Select the first video to be included from the folder where 
the video clips are stored and click OK.

Fig. 9.4 Window to Add Video to Project Bin

The settings to be used are 
according to the video 

format, right?
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Haven't the imported video clips appeared in the Project Bin 
(Figure 9.5)?

Fig. 9.5 When Video is Added to the Project Bin

Now add other required video 
files and audio files in the same 
way.

To the Timeline for 
Editing
Add files added to the project 
bin  to the Timeline for editing. 
Editing process involves 
arranging each file in the audio/
video track in the timeline 
according to their priority (time 
order).

If you need to make changes to the included clips, you can do 
that in the timeline.

To add files to the timeline, simply select the required ones 
from the Project Bin and drag them to the track (Figure 9.6).

Timeline

The timeline is the workspace where you arrange video clips, images, and title clips in 
chronological order. Typically, timelines contain separate video tracks and audio tracks for 
organization. Editing is completed by placing video clips, images, and title clips on the video 
track and audio clips on the audio track.

Fig. 9.6 Video Clips when Included in the Track
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When imported video clips contain embedded audio the audio 
automatically appears in a corresponding audio track, below 
the video track .

 You can play and stop the video/audio files included in the 
track by clicking the Play/Pause button in the Clip Monitor or 
pressing the Space Bar.

Let's Remove Unwanted Clips
You've now previewed your video clips. See if every part of 
your recorded clips needs to be included in the final video. 

Certain sections likely require trimming.

Locate the Razor Tool in the timeline's toolbar . Click on video 
clips at points needing separation , select unnecessary portions 
and delete them.

How to Remove Unwanted Parts from Video Clips

	� Move the Playback Head along the timeline to identify parts to remove.

	� Select the Razor Tool .Click at the start point of the unwanted section. Click again at the 
end point. This isolates the unwanted portion as a separate clip.

Unwanted portions of dialogues and background music can 
also be removed using this same method in the video.

Let's Arrange the Clips Properly
Since we need to organize the visuals in the timeline according 
to our script, after removing unwanted portions from each clip, 
we must now properly arrange them in the tracks. 

If we don't need the existing audio in the video, we can remove 
just the audio separately. Do the steps given below.

Fig. 9.7 Razor, Selection Tools

	� To delete unwanted Clip, switch to the 
Selection Tool , Right-click  →  Delete 
Selected Item( press Delete Key on 
keyboard)
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To Add more Tracks

In some cases, you may need to 
add new tracks to your project. 
To do this, right-click on the 
header of an existing track, 
click Insert Track, specify which 
track (Audio/Video) and where 
(Above/Under), give the track a 
name, and click OK.

 To Remove Audio from Video Clips

	� Right-click the video clip

	� Select "Ungroup Clips" from the menu (This separates the linked audio

	� The audio will appear in the corresponding audio track below.Select and delete this audio 
track.

	� To disable entire Track Audio , locate the Audio Icon in the video track header and disable 
audio for all clips in that track

Now, arrange each visual in the timeline according to their 
priority order. Use the Selection Tool, select clips one by one 
and drag them to desired positions. Same Selection Tool can be 
used to join audio files.

Transitions between Scenes
When arranging video clips one by one on a track, transition 
effects are often added between scenes to make the transition 
between different scenes more natural. Let's take a look at how 
to add transition effects in Kdenlive.

How to Give a Transition Effect between Scenes
Transition effects are known as Compositions in Kdenlive. To provide a transition when 
scenes are added,

	� Arrange video clips into two adjacent tracks, top and bottom.

Fig. 9.8 Add Track window
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	� Click on the Compositions tab.

	� Select an effect that suits the scene from the effects in 
the window and drag it to the area where the video clips 
meet.

	� To increase the duration, right-click on the effect and 
click Edit Duration. You can increase or decrease the 
Duration in the window that appears..

	� Compositions can also be created by arranging video 
files on tracks. However, not all Compositions may work 
correctly in the current version of Kdenlive.  

Now,  apply suitable transition effects between your video clips 
and preview how they work.

When Giving Composition/Effect
When it comes to adding compositions or 
effects to visuals, their selection is very 
important. Each composition or effect can 
create different levels of meaning/emotion.

Let's Add Effects
You understand how compositions are added 
between scenes, right? Similarly, to make 
videos more attractive and give them varied 
moods, we can add effects. With the help of 
the Effects tab, you can find and apply effects 
that suit your video. How to Add Effects

	� Click on the Effects tab.

	� Select the desired effect from the effects 
displayed in the Effects window and drag 
it over the video clips to insert it.

Let's Include Audio Clips
Scenes come to life through the sound 
elements included in them, right? Finding the 
right background music for our video is very 
important. We can find background music with 
the help of the internet. 

Alternatively, we can create our own using LMMS software, 
which we’re already familiar with.

For voiceovers needed in scenes, we can record them using 
any sound recording software or even a mobile phone. To 
ensure good sound quality, using an external microphone while 
recording is enough. Fig. 9.11 External Microphones

Fig. 9.9 various effects

Fig. 9.10 When Effect Added 
to the Video
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You know Audacity is an application that helps record audio on 
our computer, right?

We'll arrange the recorded audio files in the track as shown 
below.

To Add Audio to a Video

	� Just like adding video files to tracks, you can also arrange audio files in tracks.

	� To add background music or narration to a scene, place the audio in the Audio Track at the 
same time position as the corresponding video clip.

	� To remove unwanted parts of an audio file, use the Razor Tool (just like in video editing) 
to cut and delete unnecessary sections.

Let's Add Titles
Haven't you noticed how movies and 
documentaries include title sequences at the 
beginning and end? These display the film's 
title along with the names of cast and crew 
members.

We can  add title sequences to our videos too.

Discuss and decide which titles to include in 
the prepared video. Then, using the "Add Title 

Using AI for Music and Voiceovers 

AI advancements have made it easier to 
create background music and voice-overs. 
Several tools are now available to assist with 
this. For voice-overs, you can use AI tools 
like Anuvadini AI, which converts text into 
audio. Simply provide the narration as text, 
and it will generate the audio for you.

Clip" option, we can insert them into the video (see Figure 
9.12).

To Create Title

	� Open the Title Editor window 
by going to Project → Add Title 
Clip.

	� Use the Text Tool to type and 
add the required information in 
the title clip.

	� From the Properties window, 
select the text colour, size, 
font style, and other formatting 
options.

Fig. 9.12Add Title Window
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	� Select a desired background color from the Background window to enhance the title's 
appearance.

	� Use the Selection Tool to adjust the text position as needed.
	� Click the Create Title button to save the title.
	� The title clip will now appear in the Project Bin. Drag and drop it from there into your 

video timeline.

Let's Export the Video
Currently, all the edited clips and titles are saved as a Kdenlive 
project file. However, to share the video on social media 
platforms, we need to convert it into a video file format.

To do this, we must render the project file into a single video 
file.

Use the Render option in Kdenlive software.Process your 
project to convert it into a standalone video file (see Figure 
9.13)

To Render the File

 Fig. 9.13 Rendering Window

	� Save the project.

	� In the Project menu, 
select Render.

	� In the Rendering window, 
select the folder where 
you want to export the 
video and enter the file 
name

	� Select the video format to 
export. (Eg:- MP4 H264/
AAC)

	� Then click Render to File.

Isn’t the video ready?Play the video using a video player to 
preview it. If you feel any further changes are needed,  open 
the saved Kdenlive project file and make the necessary edits.
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Online Video Editors and Mobile Apps
Several online video editors and mobile apps are now available for video editing. Mobile 
apps like InShot, PowerDirector, VN, Filmora, and Canva can be used for video editing. 
Online video editors such as Canva, InVideo AI, and Clideo are accessible on the internet. 
Many of these tools also utilize AI capabilities to enhaOnline Video Editors and Mobile 
Appsnce functionality.

Let’s Evaluate

	 Can you identify which shot type is shown in the given 
image?

		  a)  Wide Shot	  		  b)  Close-up Shot		
	 c)  Medium Close-up		  d)  Extreme Wide Shot

	 As you already know, a video created in Kdenlive with 
HD720p 25fps project settings will have a resolution of 
1280×720. What would be the video size of a project 
created in HD1080p 25fps profile?

Extended Activities

1.		 Record and edit video footage of cultural performances during the school anniversary 
celebrations using Kdenlive editing software.

2.	 Produce a video message from the principal for distribution across school groups on 
December 10 (Human Rights Day).

3.	 Create an educational Instagram-style reel video to raise student awareness about the dangers 
of drug abuse.

		  a) 1280x720				    b) 720 x 576		

		  c) 1920 x 1080  			   d) 3840 x 2160


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Chapter 10

Smooth Presentation
Observe the image given below. This is the visualization of the content included in a presentation 
prepared by Aleena and her team as part of a science project.What concepts about plant cells 
and animal cells are being exchanged in this presentation?

Plant Cells and Animal Cells -Model Image
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•	 Cell Membrane

•	 ....................................................................

•	 ....................................................................

•	 ....................................................................

When presenting their prepared sideshow to the audience, what 
if they include all the key facts introducing cell organelles—just 
like illustrated above—in a single slide? Detailed explanations 
for each could then be included in the subsequent slides.

Listen to the conversation provided below.

Can't the slides be 
displayed consecutively 

in a slide show?

From the slide containing 
the  main ideas, various slides  

explaining these can be  
displayed as needed.

The main components of cells are similar in both animal and 
plant cells, but their specific features and parts are different, 
right? Therefore, it's not necessary to present the topic through 
consecutive slides.

In such situations, is it possible to go directly from the main 
slide to other slides containing detailed explanations of the 
information? That is, can we navigate from the first slide to the 
fourth slide and vice versa, and so on?

Let’s examine.

Navigator

In LibreOffice Impress 
software, the Navigator 
system helps to structurally 
organize the slides. All 
elements included in the 
slides such as images, tables, 
text frames, objects etc. will 
be visibly displayed here. The 
Navigator system helps to 
efficiently search and select 
required items, reorganize 
them, and manage them 
effectively.
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Navigation between Slides
In presentations prepared using LibreOffice Impress, we can 
examine how to create links that allow moving from one slide 
to any other slide (and back again), enabling comprehensive 
topic delivery.

Linear and Non-Linear 
Presentation Methods

By default, presentations follow a linear 
method where slides are displayed one after 
another in sequential order. This represents 
a straightforward, linear narrative style. 
However, presentations can also be delivered 
non-linearly. This is a method of reaching 
any specific slide directly from another 
slide. The interaction techniques available 
in presentation software can be used for this 
purpose.The variety in narration, ease of 
navigation, and comprehensive exchange of 
ideas are some special features of the non-
linear narrative method.

A presentation file about cell parts has been 
provided in your School_Resources folder 
under the name Cell_Structure.otp. Open the 
Home folder on your computer and examine 
this file. 

Test the presentation file using slide show mode. 
As shown earlier, you can see the main slide 
(Slide No. 2) that should contain comprehensive 
concepts is incomplete.

On this slide, mark and include images of 
both animal and plant cells along with their 
similarities and differences, then complete it as 
shown in the model shown in Figure 10.1.  

Fig. 10.1 Model of the Slide to Complete
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Adjusting the Slide 
Background

To set a background for 
slides, first select the slide.  
From the Sidebar Settings 
on the right side, choose 
Properties→Slide.  Various 
background customization 
options will be available 
including
Pattern, Color, Bitmap, and 
Gradient.  Select and apply 
the most suitable option.  

Completing the Slide Content

	� Open the Cell_Structure.otp file and select the second slide. Insert images either through 
the menu bar (Insert→Image) or by clicking the Insert Image icon on the toolbar. From the 
School_Resources folder, add the Plant_Cell.png and Animal_Cell.png image files.   

Fig. 10.2 When Images are Added to the Slide

	� Adjust the size of the images as shown in Figure 
10.2.

	� Use Insert→Textbox to type and add necessary 
text (Figure 10.3).

	� To label cell components, click on Lines and 
Arrows in the toolbar and include Line Ends 
with Arrow where needed (Figure 10.3).

Fig 10.3 When Texts, Arrows  are Added to the Slide. Fig 10.4 Lines and Arrows

No. 
Separate slides are 
to be prepared, to 

explain each

Are Cell wall and  
cell membrane the 

same?



Smooth Presentation

81 Information and Communications Technology-VIII

While displaying the prepared slide, it should be possible to 
present details about each cellular component as needed. For 
this, when clicking on images or text of cell parts in the slide, 
the presentation should navigate to other slides containing their 
detailed explanations.

To implement this, the Interaction feature available in 
LibreOffice Impress can be used. Similar to how navigation 
works from one webpage to another in a website, the Interaction 
facility helps connect slides together.

For example, let's try linking the text "Cell Membrane" in the 
second slide to the sixth slide using the interaction method as 
shown below:

To Add Interaction

	� Select the text "Cell Membrane" and right-click. From the options menu, choose "Interaction" 
(see Figure 10.5)

	� In the window that appears, under "Action at mouse click", select "Go to page or object". 
In the "Target" section, choose the relevant slide (e.g., Slide No. 6) that contains detailed 
explanation of the concept.

	� When setting up interactions this way, be careful not 
to preserve the presentation's default behaviour where 
clicking anywhere advances to the next slide. To maintain 
this: go to the menu bar Select Slideshow → Settings under 
"Change slides by clicking on background" and remove the 
checkmark (see Figure 10.6) 

Fig. 10.5 Steps to Give Interaction to a Slide

Fig. 10.6 To Avoid Transition on 
Mouse Click
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In the manner given above, the activity can be completed by 
providing interaction to the related explanation slides from the 
other sentences in the second slide. Then, run the slide show 
and click on the interaction link. Is navigation to the specified 
slides not possible?

You just need to 
give an interaction 

on that slide.

How do I get back to 
the main slide after the 

interactive slide?

To make navigation between slides easier in interactive 
presentations, you can provide buttons like Home/
Previous/Next and link them together with interaction.  
A Home icon for the main slide and arrow buttons for 
moving forward and backward (Figure 10.7) can be 
included.  

Buttons and Icons

Buttons and icons are available in 
the Gallery in LibreOffice Impress 
software. The Gallery is located in the 
Sidebar Settings on the right. It includes 
Arrows, Bullets, Diagrams, and Icons.  

Fig. 10.7 Slide in which Interaction Buttons are Included

In this way, all the slides in the presentation can be completed 
by providing interaction as needed. We can provide interaction 
to any object on a slide, starting with pictures and shapes. The 
Interaction option is available not only through the right-click 
method but also through the main menu. Let's explore and find 
out where it is.
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We know that the main function of Chloroplasts, which is 
explained in the fourth slide of the presentation file we are using, 
is photosynthesis, which is a massive process. If a video about 
this is added to the presentation, it will be more helpful for the 
presentation. The concept of interaction can be useful for this.

Interaction with Video

When inserting a video via the Insert→Video menu, we have limitations in how we can 
position the video and explain the content where needed. The solution to this is to add the 
video via Interaction. When adding video/document resources available on our computer, 
it is best to save them in the same folder as the presentation. If their location changes, they 
may not work correctly in the presentation. To include a video/document through interaction, 
simply click Go to Document and browse to the file in question.

What if we want to include information from a web page on 
the Internet in our presentation instead of a video saved on our 
computer? For that, we can introduce another concept available 
in presentation software.

Resources from Outside   
You can link web pages on the Internet to your presentation 
using the Hyperlink concept. Using this concept, link the word 
Photosynthesis on the sixth slide to its Wikipedia page with its 
details.

To Hyperlink a Web Page
	� To include a hyperlink to information about Photosynthesis, first add an Icon/Button/Text 

to the slide.

Fig. 10.8 The Steps to Include Hyperlink
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	� Then, select the reference/button (here ‍‍‍�text) and click Insert → Hyperlink.

	� n the Hyperlink pane that appears, select Internet from the left side

	� Type the address of the Wikipedia page in the text box next to URL and click OK.

What if the button appears 
after the Chloroplast 

 have been explained?

MORE ABOUT... 
When I see this button, 

 it's the first thing you want to 
click.

The webpage is hyperlinked. Hyperlink can also include video/
documents via the Document→ Path method available on the 
web.

During a presentation, it would be more efficient to present 
the ideas in a slide in context rather than presenting them all 
at once.

The Content can be Displayed as Needed
You can use the Animation technique available in LibreOffice 
Impress to make the content on the slide more visual. Watch the 
animation in a way that lists the main facts about Chloroplasts 
one after the other.

How to Apply Animation

	� Select the text you want to apply animation and select the Animation method from the 
Sidebar Settings on the right.

	� Click the button next to Effect <image> in the Animation window that appears.
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Fig. 10.9 Let’s Provide Animation Fig. 10.10 Animation Settings

	� Under Effects, you can also adjust the Duration, Delay, and Direction settings as needed 
(Figure 10.10).

	�  You can preview the animation by clicking Play next to Automatic Preview (Figure 10.10).

We display slides during presentations using the Slideshow 
technique.Just as animation makes the content appear more 
attractive, what if each slide appeared more attractive during 
the presentation?

When the Slides are Changing
You can make the slides appear visually appealing by giving 
them a transition effect. Try giving your presentation a Slide 
Transition in the manner given below.

How to Apply a Slide Transition

 Fig 10.11 Slide Transition Settings

	� Select the desired slide and choose Slide → Slide 
Transition from the menu bar or Slide Transition  
from the Sidebar Settings.

	� Then review the listed transition effects and select the 
one that suits you.

	� Make the necessary changes to the Variant, Transition, 
and Sound transition settings (Figure 10.11).

	� To apply the same effect to all slides, simply click the 
Apply Transition to All Slides button.
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Apply slide transitions, save the presentation file, and then 
present it to the class.

Let’s Evaluate

 	 What could be the reason why a video embedded in LibreOffice Impress via 
Hyperlink/Interaction is not working?

	 a)	 The video does not have sound

	 b)	 The video was moved from the saved folder while preparing the presentation

	 c)	 The video file size is 15 MB

	 d)	 The video content is not supported

	 Select the incorrect statement from the following regarding Interaction in LibreOffice 
Impress.
a) 	Navigation between slides can be customized as per the requirement.
b)	 Presentation can be shown in a customized manner by providing interaction.
c)	 Resources can be included in the presentation through interaction.
d)	 Navigation of slides is possible only by providing interaction.

Extended Activities

1.	 Prepare a presentation using LibreOffice Impress software to be presented in class, including 
details of endangered wildlife species and ways to conserve them, in connection with  
National Wildlife Day.   

2. 	You have been introduced to the unlimited possibilities of using the Internet in the previous 
chapter. Prepare a presentation in LibreOffice Impress for conducting an awareness class 
on the things that we should pay attention to while using the Internet. Use the techniques 
Hyperlink and Interaction in the presentation.





CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national 
struggle for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon 
to do so;

(e) 	to promote harmony and the spirit of common brotherhood amongst 
all the people of India transcending religious, linguistic and regional 
or sectional diversities; to renounce practices derogatory to the 
dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, 
lakes, rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry 
and reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and 
collective activity so that the nation constantly rises to higher levels 
of endeavour and achievements;

(k) 	who is a parent or guardian to provide opportunities for education 
to his child or,  as the case may be, ward between age of six and 
fourteen years.



CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in


